
DRAWING PROJECT 1

In Accucadd there are many precision drafting tools, such as the Orth trap, which

gives you perfect horizontals and verticals. Snap grid is another useful device for

organizing the work area.

[] Wipe the drawing page (select Edit: Wipe).

[] Select Grid from the Toolkit menu. This will turn off Orth if it’s on.

You can configure the grid palette, Figure 10, to suit your exact needs. For now, use

the preset “default” settings.
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Figure 10: Snap Grid palette
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n = 2 (show every second point)
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Cancel (Remove palette)

Grid “Off”

Grid “On”



In some cases, the initial settings for various functions may not match the

tutorial. Simply change them before proceeding. In most cases, this means

touching the numerical value on the palette and typing in the desired value.

Use the Save Setup feature, if desired, to make the new values the start up

settings.

[] Make sure the right-hand grid is selected, then turn it on by touching the check

symbol.

The cursor is no longer free to roam around the screen. Instead, it jumps (“snaps”)

from point to point in 0.25" increments. (You can steer it between points: it snaps to

the grid when it’s within the Trap Zone--see Set Up: Snaps).

[] Draw a rectangular box 6.0" x 2.5"., as Figure 11. It need not be centrally

positioned. To start a line, touch a chosen snap point to set the datum, then move

out to the desired end-point, while keeping an eye on the dimension display.
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Figure 11: Starting the project



Touch to draw the line. If you find you have set the datum in the wrong spot, use the

Esc key to free the cursor, then try again.

Next, we draw a circle in the center of the rectangle. With the grid in place, this is very

easy to locate:

[] Touch the top left corner of the rectangle. Move 3" to the right, hold the pointer

there, then press Esc. If you haven’t moved it, the cursor will still be “snapped” to

the same spot.

[] Touch the spot to make that the new datum, move 1.25" down to the center of

the rectangle, then press Esc again. You may wish to mark the center with a

short line, which you can later erase; don’t bother with this if you have a good

mental image of the center location.

[] Touch the circle icon from the “elements” palette, as Figure , then touch the

center of the rectangle. Now, with its center established, the circle can be

expanded to the desired diameter simply by moving the + cursor on the
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Figure 12: Adding a circle



circumference. Using the snap grid (and dimensions display), set a 3" diameter

circle, then touch to draw.

The center of the circle is itself a “magnetic” snap point, just like the end-point of a

line. This means you could draw concentric circles even if the grid were turned off.

Check this by turning on Points, as in Figure .

A more flexible way of drawing a circle, with or without a grid, is to set its center, then

key in the diameter:

[] Set the center of your next circle in the same place as before (touch). Key in

2.625, then press Enter to draw. (See Figure 12)

In addition to the one you just drew, there is now a “free” circle you can move around

(press Esc to cancel it, but not now); you could, if you wish, draw any number of

2.625" diameter circles all over the screen, without respecifying their dimensions.

(Don’t do it now, but remember this for the next time you want to set out a number of

bolt holes in a plate.) Here, we need three more circles concentric with the first.
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Figure 13: Concentric circles



[] Steer the “free” circle back to coincide with the fixed one you just drew; hold it

there while you key in 2.25, then press Enter to draw.

[] Draw 0.75 and 0.50" circles in the same way - hold the pointer at the center, key

in the diameter, then Enter to draw.

[] Turn off the grid by touching the x symbol on the grid palette, then remove the

palette itself by touching the [C].

Now we want to take a closer look at the drawing - or a portion of it - so we magnify it

using Zoom.

[] Select View, then Zoom. The + cursor, which is going to be the center of the

zoom window, is “snappable”, just like the regular drawing cursor. Snap it to the

center of the circles, then move away. The rectangular window marks the area

that will be enlarged to full-screen when you execute the zoom.

The magnification is reported continuously by the dimensions display.
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Figure 14: Zoom window set for 2x magnification



[] Set the window so that it just encloses the area of interest, then click to execute.

Alternatively, you can set the magnification precisely by keying in a numerical

value, followed by ENTER, as in Figure 14.

Part Erase, a powerful editing facility, is similar to Erase except that it automatically

recognizes intersections, and doesn’t go beyond them. (As you saw earlier, Erase

removes entire elements.)

[] Select EDIT, then Erase.

[] Make sure the Part Erase icon is selected in the upper right of the Erase palette

as shown in Figure 15.

[] Place the rectangular “trap” cursor over the larger circle, where it extends

beyond the rectangle, as Figure 15. Click to confirm; the selected portion is now

tagged with end markers and a cross. Tag the other protruding segment at the

bottom of the rectangle in the same way, then execute by selecting the check

symbol (on the Erase palette).
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Figure 15: Part Erase “trap”



If you make a mistake and select an element you do not wish to erase, simply

touch on the same element a second time. This will “de-select” the element.

This same method of de-selection also applies to the Change, Copy, and Move

commands.

[] Still in the Part Erase mode, chop out all segments of the rectangular outline

within the outer circle, as Figure 16.

[] Exit Erase by touching the [C].

Now, instead of removing an element, we can change its appearance. This is done

using the Edit:Change command. This command allows you to change an element’s

line weight, line type, color, or layer.

[] Select Edit, then Change. We will change the outline of our part to line weight 2.

To use Change, we must first select the elements to Change, then tell the system

what to change about the selected elements.
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Figure 16: Segment removal using Part Erase



[] Select every element of the outline (which is now in two halves) for change as in

Figure 17 and touch the check symbol. (The selection markers will no longer be

displayed.)

[] Select line weight from the change palette, and select line weight #2 as in

Figure 17. Touch the check symbol to execute the change.

Experiment by changing other elements, e.g., the outer circle to line weight #3. You

can change it back to #1 if you wish.

[] Reselect line weight #1, then touch the line type icon. Select line type #5, and

apply that to the inner circle. Exit the change mode by touching the [C].

[] Select View, then Redraw. This replays the drawing at its original size, but now

with the amendments you made in Zoom.

[] Select line mode from the elements palette.
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Figure 17: Elements tagged for line weight change, and line weight selections



[] Select Snap Grid from the Toolkit. Before switching on the grid, touch any

corner of the rectangle. This serves as a reference location (datum) for the grid,

which we want to display in exactly the same position as before, relative to the

drawing.

TWO DIFFERENT SNAP GRIDS...

Both grids on the palette have adjustable spacing, and different spacings may be set

for the horizontal and vertical “axes”. The left hand grid id fixed in position--the

“origin” is at the screen center, and marked with heavier lines--and also fixed in

orientation. The right hand grid is fully programmable, which means you can also

change position (origin), and the alignment of its axes. (If you touch any of the

numerical displays on the palette, you will be invited to key in a new value.

Experiment if you wish, but return to the original settings before proceeding.)

[] Switch on the right-hand grid by touching the check on the grid palette. (If the

grid doesn’t coincide with your drawing, touch the x to turn it off, set its datum,

then turn it on again.)

[] Select line type #1, and weight #2, to match the rectangular outline.

[] Touch the 3-point arc icon on the elements palette, as Figure 18. Plant the first

point two grid units (0.5") down from one of the top corners of the rectangle, and

the second point two units up from the corner below it. Set the + cursor on the

“rubberbanded” arc to give a symmetrical concave surface, 0.25" deep, then

touch to draw the arc, as shown at the right-hand side in Figure .

[] Repeat at the other end of the figure. Erase the chord from each arc using

Erase - part item.

[] Select Draw, then Fillet. Set the fillet radius to 0.25"; touch the numerical

display [r], key in .25, then press Enter.

[] Zoom x2 to get a closer look, as Figure 19. “Trap” line (A), by planting the

rectangular cursor over it (anywhere will do), touch once, then do the same thing

with the adjoining line (B). This displays a full circle, which you can drive around
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to display the several possible fillet locations. Choose the inboard one as shown,

then touch to draw the fillet.

[] Fillet the other three corners in the same way. Set the fillet radius to .125, then

fillet the four “horns”.

[] Use Part Erase to trim the filleted corners, as Figure 19, below.

In Accucadd, you can also use the automatic fillet trim feature to avoid having

to trim the fillets with Erase. The fillet trim icon is part of the Fillet palette.

PALETTES IN THE WAY?

Move the elements and line-type palettes out of the way by snagging them with the

“hand” symbol, which appears as you just move into the palette top area (gray bar).
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Figure 18: Three-point arc



Press and hold the left mouse button, drag the palette to where you want it, then

release the mouse button.

ZOOMING AROUND...

Sometimes, you will find yourself shuttling from a zoom view to the full-page view,

then back again to the same zoom view. You can save the trouble of setting up the

zoom window each time by using the save zoom feature. When you are through

working on a zoom view, select View, then Save Zoom. Save the view by touching

any of the 16 listed memory locations. To recover the view, select View, then Load

Zoom by touching the same spot on the memory list. You can also name the views to

help you remember what they are. Another trick you can use in zoom is to shift your

point of view, as though you were roaming around with a magnifying glass - useful

when the feature you need is just off-screen. Once in the zoom view, select View,

then Pan. Touch any point in the work area with the cursor, then indicate with a

second touch where you would like that point relocated; Pan is then executed,
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Figure 19: Filleting of lines and arcs

A

B



drawing a fresh zoom view with the same magnification as before. You can also use

the Windows scroll bars, and if you have an Intellimouse, you can use its pan

functions.

[] Select VIEW, then Redraw the base view.

[] Select DRAW, then Hatch.

There are eight basic hatch patterns. However, since each of these can be drawn in

eight line weights, and eight line types, there are several hundred to choose from. As

you can also change the pitch (line spacing) and the color, too, there is actually

almost an infinite variety.

The pitch we’ll use is 0.15". Touch any of the numerical displays (.15"), and you will

be invited to key in a new value, followed by Enter. Experiment if you wish, but

restore the top two patterns to 0.15.
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Figure 21: Defining an area to be hatched



Hatch will fill any closed area defined by any combination of lines, arcs (including

fillets), circles and curves .

[] Select line weight #1; then, with the default pattern (top left) selected, plant the

hatch “seed” by touching any point within the boundary at left of the drawing.

[] Now define a rectangle which fully encloses (but only just) the area to be

hatched (the idea of this is to cut down on processing time by rejecting as much

of the work area as possible). Touch to plant the first corner of the rectangle, then

move away to expand the window, as Figure 21. Touch the opposite corner to

execute the hatch. Use Esc to free the cursor if you get it wrong the first time.

[] Select the top right pattern, then hatch the opposite boundary. Exit the Hatch

mode by touching the [C] on the hatch palette.

We are just about ready to save your drawing in the library, marking the end of this

first project, but first we need to add two center lines and a title. In some versions of

Accucadd, the text parameters are reported in fractions of an inch, not decimals.

Your version may display ¼ rather than 0.25 – this is not an error.

[] Select Redraw to display the base view, then select Snap Grid. Touch the

center of the circles to set datum for the grid, then turn on the right-hand (0.25")

grid.

[] Select line type 7, then draw two center lines 1" in from each end, as Figure 22.

[] Select Text from the Draw menu; then 1n the Text Editor window, type

“Experimental drawing”, or some other title.

[] Return to the drawing page by clicking the OK button; position the rectangular

cursor - which is carrying your label, invisibly - under the drawing, then touch to

draw, as Figure 22.

You will notice that the bottom left corner of the text cursor is a snap point. (If you

ever need to, you can turn off the grid for finer control of position.) The text palette is

displayed below.

Note that we use the word “draw” for text. The text label is composed of a series of

arcs and lines, drawn in the usual way, with any line weight of your choice.

In Accucadd, 26 different text fonts are available (default is Simplex) with adjustable

character slant.
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[] Touch the line weight icon on the text palette, then select weight #2.

[] Position the text cursor, still carrying the same label, below the previous entry,

then touch to draw.

[] Go back to line weight #1, and set the character slant to 15 degrees as in Figure

23, then add a third text label beneath the other two.

[] Change the text height by touching the numerical display (default value .25"),

then key in 0.375 followed by Enter. (Note: 0.375 may be reported as .38

depending on the Precision setting under Set Up.)

[] Add the fourth text entry, as Figure 23.

[] Before saving the drawing, you may wish to remove all but one of the text

labels. Select Erase; this displays an inverted triangle beneath each text label.

To remove a label, tag its “T” handle by touching it with the “trap” cursor, then

touch the check symbol to erase, in the usual way.
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Figure 22: Adding a text label



A powerful feature of Accucadd is its ability to make, and edit copies of a text label

without having to retype the whole thing. For simplicity, the editing capabilities of the

different versions of Accucadd are described separately. We do recommend ,

however, that you read each section because of backward references in the text.

EDITING TEXT WITH Accucadd ...

[] Select Text from the Edit menu, and select a text entry by touching its tag; this

redisplays the label on the Text Editor window.

[] Edit the text in the usual way; position the cursor with the left/right directional

arrows, then key in new material (the “old” text moves right to accommodate the

new). Use the Del key to delete characters, left of the cursor, one by one. If you

wish to change only the style, height, or weight of the label, just return to the

drawing area as directed below.
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Figure 23: Changing text style, weight, and height



[] Return to the drawing page by clicking the OK button. Make any changes to the

Text palette, position the text cursor in the desired location, then touch to draw

the text.

Anytime you have a text cursor active on the drawing page, press the F3 function

key to redisplay its contents in the text editor.

Text Editing functions

[] Select Edit - Text. This displays a palette with the options to Copy, Replace,

Move, (change the) Font, or Change (the other text properties). Select Move and

choose the Text to edit. This will place the text in the text cursor. Anytime the text

cursor is active on the drawing page, the first 30 or so characters of the text will

be displayed in the staus bar.

[] Press the F3 function key to place the text in the Text Editor. Anytime the text

cursor is active on the drawing page, F3 places its contents in the Text Editor.

[] Edit the text.

[] Return to the drawing page by clicking the pointer button, make any change to

the Text palette, position the text cursor, then touch to draw the text.

The Text editing capabilities are described briefly below:

Copy copies the selected text entry into the editor and allows access to text

attributes before planting.

Replace copies the selected text entry into the editor for alteration, then places the

altered text at the same point with the same attributes as the original text.

Move displays the text box and allows access to the text attributes.

Font allows you to change the font of existing text.

Change displays a dialog which allows you to select, and change, one or more of the

following text properties:

Height, Line spacing, Character spacing (spacing between one character and

the next), Character slant (”italics”), Rotation (of the entire block of text), and Line

weight.
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Now we come to an important operation in the CAD process - saving the drawing so

that it can be worked on later. This operation is called “filing in the library”, or “saving

to disk”.

[] Select File from the LIBRARY menu.

A library index of pre-drawn material is now displayed, e.g. Figure 24. (See the

Reference Manual if you are creating your own library disk from scratch). This index

is a unique feature of Accucadd. It is a visual catalog of library contents, displayed as

micro-images. This eliminates the need, when filing a drawing, to assign it a file

name or number (which, if you don’t make careful notes, there is a chance of your

forgetting, or worse).

The “box” size is adjustable, and you should select a size large enough to display an

identifiable image. For a small component drawing, such as a schematic symbol,

the default box width of 4 units (or less) is fine. Try changing the size to 8 units:
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Figure 24: Library index, with Project 1 filed at bottom right



[] Touch the numeral 8 on the “size table” at right. This doubles the width of the

rectangular cursor. Change it back to 4 units.

Box size has nothing to do with file size. There is nothing to stop you assigning a

small box to a drawing with hundreds of elements. The file will be intact, but you wont

have a recognizable micro-image.

[] Steer the rectangular cursor to the bottom right corner of the page (or any other

free space you wish), then touch to execute the filing process.

You will be prompted to Move (reposition drawing before filing), Add label, or Exit

(which means return to the drawing screen); you must do one of these.

[] Select Add label.

The Text Editor window appears, prompting text entry in the usual way - but keep it

short, e.g. “Project #1". Click the pointer button to enter the label, as Figure 24. Note

that this label is not a filename recognizable by the computer. It is only information

added to avoid confusion in cases where there are several similar micro-images.

What is filed in the library is always the complete, unzoomed drawing (the “base”

version), regardless of the view you had on the screen when you selected File.

With your drawing safely filed away, you can end the work session.

[] Select Exit from the File menu. If you get the “Save Settings On Exit” dialog,

touch Cancel. When you get the Exit dialog “Data will be lost … Exit?” respond by

clicking the “Yes” button. This dialog is a reminder to save your work, if you have

not already done so.

THERE ARE OTHER, FASTER WAYS ...

You’ve seen how a snap grid can help organize the work area, and get things going

fast. With a grid in place, try a new kind of drawing element - the rectangle. The

rectangle icon is shown in figure 25, which identifies all the drawing elements.

[] Touch the rectangle icon on the elements palette, Figure 25 (below).

[] Plant the first corner of the rectangle by touching any snap point on the grid,

then move away to expand the figure.

[] Snap the opposite corner into place, then touch to draw the rectangle.

Accucadd Quickstart

Page 1-18



Drawing Project 1 started with a 6" x 2.5" box,

which happened to fit nicely on the default

snap grid. But suppose the dimensions were

not so convenient (i.e., more realistic), such

as 6.125" x 2.938". No problem; you can

handle this in many ways.

ORTH TRAP METHOD

[] Wipe the system, select Orth Trap and line

mode, then touch the spot you wish to be the

top left corner of the rectangle.

[] Point the cursor right, along the trap line,

then key in 6.125, followed by Enter.

[] Touch the right end of the line you just drew,

then point the cursor down; key in 2.938,

followed by Enter.

Complete the rectangle, then locate its center:

[] Touch the top left corner again, point to the right, then key in 3.0625, but don’t

Enter; instead press F11, which transposes the datum without drawing a line.

[] From the new datum, point the cursor down, then key in 2.938 / 2, followed by

F11. You now have a solid location - the trap intersection - to plant the circle.

Any time Accucadd asks for numerical data, you may enter expressions with a mix of

addition [ + ], subtraction [ - ], multiplication [ * ] and division [ / ], in any order (with

attention to the usual rules of algebra, please). You can use parentheses [ ( ) ] to

clarify the expression.

DELTA METHOD

[] Wipe the system and select line mode, if it’s not already active. Orth Trap is

optional.

[] Touch any point in the approximate center of the work area, making that our

reference location, i.e., datum.

[] Press the F6 function key. Throughout this tutorial, this action is referred to as

Delta.
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Figure 25: The drawing elements
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This activates Accucadd’s Delta coordinate entry. It invites you to enter a pair of

coordinates to which the datum will be shifted. We use the standard convention,

where Y increases as the cursor moves up the screen, and X increases to the right.

The objective is to draw a 6.125" x 2.938" rectangle, symmetrically placed relative to

the datum you just established:

[] Key in the X, Y coordinates of the top right corner: 6.125/2, 2.938/2. Now press

F11 to shift datum.

[] Select Delta, then the coordinates of the top left corner, relative to the new

datum: -6.125,0. This time press Enter to draw a line and shift the datum.

[] Touch the left end of the line, key Delta, then key in the bottom left corner:

( 0, -2.938 ) followed by Enter.

[] Draw the third side in the same way. The fourth side, of course, you can snap

from one end-point to the other, without typing anything.

POSITIONING A CIRCLE

You can also use Delta to plant a circle relative to a datum. (This works equally well

with compass arcs.)

[] Still in the line mode, touch the top left corner of the rectangle to set the datum

there, then select the circle icon from the elements palette.

[] Key in the coordinates of the center of the rectangle: 6.125 / 2, -2.938 / 2, then

press Enter. This shifts the datum, and fixes the center of the circle, so all you

have to do now is key in the diameter in the usual way.

MAKING AN INTERSECTION A SNAP POINT

Here’s a neat way of finding the center if you don’t know the rectangle’s dimensions.

[] Wipe the screen and draw any rectangle.

[] Select the line mode and draw two diagonals.

[] Select Points from the Toolkit menu, then activate the “intersection locator” by

touching the check symbol as Figure 26.
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[] Touch the intersection of the diagonals with the trap cursor, then deactivate the

“locator” by touching the X.

The intersection has become a snap point, just like any other element on the

drawing. You can locate more than one intersection at a time - just go around with

the trap cursor, touching each one in turn. The intersecting elements themselves

can be erased without affecting the snap points.
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